Unity Concepts
UPAAte ... 47
Fixed Update...........coooooeeeeeee e 51
B L2 2 (=TSO OO 54
1] 71 o OO OO 58
AWAAKE ...ttt 62
SCENES. ...ttt ettt ettt eteaes 65
L@F-1 1 o 1=] - OO 70
CINEMACKING. ...t 74
Rigidbody PhySICS...........coooiiiicc e 82
COllIARIS ...ttt 86
TGOS ..ttt 93
GaME ODBJECES ..o 97
Prefabs ... 100
INSEANtIAtE ... 105
TRANSIALE........ooeeeee ettt 109
DESTIIOY ...t 112
RAYCAST ... 115
INVOKE ...ttt 121
Player INPUL...........o.ooo e 125
Movement Touch Controls..............ccoooiiiiiicceeeeeeeeeeeeeeeeea 131
Action Touch Controls ..o 143
PartiCles ...t 151
Materials and TeXtUIES.............cooiiiiiieeeeeeeeeeeeeeeeeeee e 157
SoUNA ANA MUSIC........ooeeeee et 162
TGS ottt st ne 167
& CODENINJAS'

Copyright © Code Ninjas, LLC |46




Update

The Update function runs every frame and makes objects in your game
move and change. Unity renders frames of your game as fast as it can,
meaning that the Update function will run at different rates based on a
computer'’s speed and the scene’s complexity. Because you cannot
predict exactly how often the Update function will run, it is helpful to
use Booleans and Time.deltaTime to control what happens inside the
function.

()

horizontal =
vertical =

movement or3 (horizontal, 0, vertical);

transform.position += movement * Time.deltaTime * speed;
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The Update function is automatically created by Unity in each new script.

If you need to access a different game object or component, you should use
GetComponent or FindGameObjectWithTag in the Start function and store a
reference in a variable. You can then use that variable in your Update
function.

0 references

0 references
()
{
agent .destination

}

In this example, we find the obstacle game object and the NavMeshAgent
component in the Start function because these two functions take
resources to run and their results won't change if we call them again.

In the Update function, we set the agent's destination to the obstacle’s
changing position each frame.
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Conditional statements with simple Booleans can help you determine if you
want to run a specific section of code on the current frame.

0

if (canMove)

vertical = Input.GetAxis("Vertical");

forward * Speed * Time.deltaTime * vertical;

wve) ;

In this example, we use a canMove Boolean that is calculated outside the
Update function. If canMove is false, the code inside does not run. If
canMove is true, then Unity polls for Player Input, calculates a movement
Vector, and applies a Translate to the transform.

Since the Update for each object is run each frame, it is important to make
sure your Update code stays relatively simple. If you have 100 enemies that
each perform complex tasks in their Update functions, your game will slow
down a lot!
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Examples

In Shape Jam, we used the Update function to determine when to
spawn new enemies. It has several conditional statements and uses
Time.time to calculate when new enemies should be Instantiated.

3 Find the Update function and look at the code that is already present.
There's less code than the last Update function that we looked at!

In Sulky Slimes, we used the Update function to check to see if the
player had lives remaining. If so, then the function would check for user

Input.

5 We now need to make sure the game ends if the player runs out of lives. We
can use pseudocode to help us add to our MouseManager's Update
function.

In the Update function,
check to see how many
lives the player has.
rsrnarererocr | [ty have more than
. zero, continue running
to prevent the other the function.
code from running.

The Update function is an essential part of game development in Unity.
Unity uses this function to modify the game objects inside the scene.
You can use it to see how much time has passed or listen for user Input.
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Fixed Update

While the Update function is tied to the game’s frame rate, FixedUpdate
runs every 0.02 seconds, or 50 times a second. Because it is called at a
regular interval, this is the best place for physics calculations. If
calculating the effects of gravity happened too fast or too slow, then
your game's physics wouldn't feel right. Code within FixedUpdate runs
at the exact same rate no matter what.

Vector3 propulsion =

myRigidBody.AddForce (propuls
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Instructions

While the Update function is created automatically in each new script, you
must create your own FixedUpdate function.

2 While FixedUpdate and Update behave similarly, they serve different
purposes within your code. Things like listening for Player Input should go in

the Update function because it is unpredictable when a user might press a
button.

On the other hand, calculating the effects of gravity or other physics should
go in FixedUpdate because the game objects need to be updated at
consistent, or fixed, time intervals.

Note: If you use Rigidbody Components and the Unity Physics Engine, you
might not need to rely on FixedUpdate to perform many calculations.
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Examples
In Robomania, we used FixedUpdate to apply a force to the enemies.

44b We now need to apply aforce to the Crusher’s rigidbody. Instead of
creating our own vector, we can use Unity's “left” vector to get a
vector that has a-1in the x coordinate and a 0 in the y coordinate. We
can then multiply the (-1, 0) left vector by the Crusher’s xForce value.
This will bounce the Crusher to the left at the same force it jumps
with.

After xDirection = -1; type

enemyRigidBody.AddForce(Vector2.left * xForce);
to apply aforce.

L)

if (transform.position.x <

I

L
xDirection = 1;
enemyRigidBody.AddForce(Vector2.right * xForce);

1
J

if (transform.position.x >

vector2.left * xForce);

Ideas

You can use FixedUpdate to modify the strength of gravity on specific
objects. You could also add a propulsion force to an object to have it
accelerate like a space ship.
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Time
One advantage video games have over real life is that you can control

time! Unity provides useful information and properties about Time in
your scene.

:t timerLabel;

UpdateTimer ()

timerLabel .text = Time.time.ToString();

D, .
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The Time property is often used to make sure things like speed are scaled
properly. Without it, the speed of game objects would be based on how
often the Update function runs. By multiplying the speed of an object by
Time.deltaTime, you are accounting for how much time has passed since
the last time the Update function has run.

void Update()

loat horizontal = Inpu

vertical = Inpt

direction = ne 3 (horizonta 0, vertical);

transform.position += direction * speed * Time.deltaTime;

If you use FixedUpdate instead of the standard Update function, use
Time.fixedDeltaTime instead.

t horizontal = Input.G & ntal") ;
Inpu X1is al™);
direction = nev 3 (horizonta 0, vertical);

at vertical =

orm.position += direction * speed * Time.fixedDeltaTime;

You can calculate how much time in seconds has passed since the start of
the game with Time.time.

xt timerLabel;

UpdateTimeSinceGameStart ()

timerLabel.text = Time.time.ToString();
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If you want to know how much time in seconds has passed since the scene

has loaded, then use Time.timeSinceLevelLoad. This is useful if your game
has different levels or scenes.

Text timerlLabel;

0 references

UpdateTimeSinceSceneStart ()

timerLabel .text = Time.time.ToString() ;

You can control the speed of time in your game by adjusting

Time.timeScale. If the value is 1.0f, then time passes as normal. If the value

is 0.0f, then time stops completely and all time-dependent objects in your

game pause. If the value is between 0.0 and 1.0, then time will slow down.
()

if (Input.GetMouseButtonDown (0))
{
Time.timeScale = 0.5f;
}
if (Input.GetMouseButtonUp (0))
{

Time.timeScale = 1.0f;

In this example, when the user presses the left mouse button down, the
game runs at half speed to create a slow-motion effect. When the user
releases the left mouse button, the game returns to its normal speed.

@ CODENINJAS'

Copyright © Code Ninjas, LLC |56



<

Examples

In Codey Raceway, we used Time.deltaTime to calculate two different
timers, a Lap Timer and a Countdown.

1 1 1 Having the decimals show up on the screen does not look so good. We can
fix that by using the Mathf.Round to only display whole numbers. Stop your
game and open the TimersCountdown script.

Modify your Update function toround both the totalCountdownTime and
totalLapTime variables before converting them to strings.

In Find the Exit, we used Time.deltaTime to make sure Codey moved at
a consistent rate no matter how fast or slow the game was running.

7C In the Update function, we want to add one line of code to move our
ninja, Codey.

To do this, we will use Unity's Translate function on Codey's
transform. An object’'s transform contains information about its
current position, rotation, and scale. Unity's Translate function will
let us change an object's position. In the void Update() function, type
transform.Translate(Vector3.forward * speed *
Time.deltaTime); to tell Codey to move forward at our set speed of 5
at a constant rate of time.

transform.Translate(Vector3.forward * speed * Time.deltaTime);

ldeas

Use Time.deltaTime anywhere you directly move a game object’s
transform in an Update function. You can use Time.time or
Time.timeSincelLevelLoad to create timers that add pressure to the
player in your game. Change Time.timeScale to create a cinematic time-
slow effect to highlight exciting action like an enemy being defeated.

D, .
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Start

The Start function runs once as soon as your game starts, before any
Update functions. As long as both the game object and the script are
enabled, your code will execute when you press Play. If you use the
same C# script multiple times, the Start function will also run every
time there is a new instance of it being used.

Enabled Game Object and Script: Start function will run.

rjf] GameObject Static
y Tag Untagged = | Layer Default -

¥ # « Concepts (Script) e i

Script Conceplts

Disabled Game Object or Script: Start function will not run.

Ng [ | GameObject Static »
y Tag Untagged = Layer Default -

v # [ ] Concepts (Script) @ !

Script Concepts

%CODENINJAS“
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Instructions

When you create a script in Unity and open it, the Start function is already
made for you.

If you deleted the Start function, you can easily recreate it.

Since the Start function does not return a value, it must have a return type
of void.

We can gather information from other components or scripts on the object
using GetComponent, but first we need a variable to store the values.

Create a variable with the type that you want to get outside of your Start
function. In this example we created a variable with a Rigidbody type
because we want to grab the Rigidbody from our object.

Rigidbody playerRigidbody;

U reterences
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4 In the Start function, set playerRigidbody to the object's component using
the GetComponent function.

()

playerRigidbody = GetComponent<>

5 Type the name of the component inside the <>. In this example, we want a
type of Rigidbody. Since this is a function, it needs to end with open and
closing parentheses.

()

playerRigidbody = GetComponent<Rigidbody>();

6 The Start function can do more than get a reference to a component on the
object. It can also be used to find other objects or initialize variables.

& CODENINJAS'
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Examples
You can find the Start function in almost every game. In Gravity trails,
we used it to access the Throwable script attached to Codey.

76 Since we are modifying the prefab object, we cannot use the Inspector to
attach game objects from the scene.

As soon as the throwable is created, we want to be able to access the
variables in the Throwable script. In the Start() function, set the value of
direction to the Player object’s Throwable component.

Start()
{

direction = GameObject.FindGameObjectWithTag("Player").GetComponent<Throwable>();

}

It was also used to determine how many enemies were in the scene.

1 06 In the Teleport script’s Start() function we want to use the
FindGameObjectsWithTag function and .Length to get the total number of

enemies.

enemyCount = GameObject.FindGameObjectsWithTag("Enemy’

Ideas

The Start function is a great way to ensure that your game functions as
expected once you hit Play. You can set the value of your variables here
so that they are always what you expect them to be.

This function can also be used to have game objects perform tasks in
the scene as soon as the game is started.

D, .
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Awake

The Awake function is very similar to the Start function, but with some
slight differences. Awake is the first function that runs when the game
object is created. It runs before both the Start and the Update functions.

As long as your game object is enabled, Awake will run even if the script
is disabled.

Enabled Game Object and Script: Awake function will run.

¥ # +~ (oncepts (Script) e 3 i ¥ i~ (oncepts (Script) 9 3 i

Sty Concepts Scin Concepts

Enabled Game Object and Disabled Script: Awake function will run.

¥ # | ( oncepts (Script) 9 3 ¥ 1 []iencepts (Script) @ 3 i

Script Concepts Script Concepts

Disabled Game Object and Enabled Script: Awake function will NOT run.

- ¥ i~ Concepts (Script) 9 3
St Concepts
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Instructions

1 The Awake function is not automatically added into the script. Since the
Awake function does not return a value, you must give it a return type of

void.

By default, Awake is a private function, but you can also declare it as a public

function if you want.

2 You can access game objects in the Awake function just like in the Start
function. You need to create a variable with the type you want to get and

give it a name.

GameObject finalBoss;

()

finalBoss = Gam ct.FindGameObjectWithTag ("Boss") ;

& CODENINJAS'
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Examples

In step 21 of the Dropping Bombs activity, you used the Awake function
so that you could access the Spawner script and all of the code within
that script.

21 We have yet to identify the spawner, which we can do when the script
first awakes. Create a void function for Awake and inside it, declare the
spawner variable as a GameObject. We will use .Find to identify the
game object by name (Spawner). We actually want the script thatis a
component part of the GameObject. So use .GetComponent<> with
Spawner as the name of the component. This means that the variable
spawner is actually the Spawner script component.
- public class GameManager : MonoBehaviou
private Spawner spawner;
void Awake()
: {
11 spawner = GameObject.Find("Spawner”).GetComponent<Spauners();

}

14 // Start is called before the first frame update

Ideas

You can use the Awake function to look for certain game objects before
anything else happens in your game. You can also use Awake to enable
certain scripts in a specific order.
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Scenes

All Unity games are made up of Scenes. A Scene contains all of the
game objects, Ul, lighting, cameras, and scripts you use to design your
game.

# Scene

e | O T T B R T —

[

< Persp
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Instructions

1 Each new Unity project starts with a Sample Scene in the Scenes folder.

MProject | EConsole

+ -

¥ = Favorites Assets > Scenes
O, All Material:
O, All Models
C, All Prefabs

v (@ Assets
B Artwork SampleSe...

Ba Scripts

2 To create a new scene, right click in the Scenes folder, select Create, and

then Scene.
Create 3 Shader :
Show in Explorer Testing
Playables N

Open .
Assembly Definition

Delete o
Assembly Definition Reference
Rename . N
eshPro
Copy Path Alt+Ctrl+C ©
Scene

Open Scene Additive
Prefab Variant

View in Package Manager

Audio Mixer
Import New Asset..

Material
Import Package >

Lens Flare

Export Package...
Find References In Scene

Render Texture
Lightmap Parameters

Select Dependencies
Custom Render Texture

Refresh Crl+R

Sprite Atl,
Reimport pr! € Atlas
Sprites >
Reimport All .
Animator Controller
— Extract From Prefab AT
Assets > Scenes )
11 Run API Updater... Animator Override Controller
Update UIElements Schema Avatar Mask
Open C# Project fl=ie
Signal
SampleSe... Physic Material

As your game grows in size, you want to make sure your Scenes have
recognizable names.

levell level2
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Unity's SceneManager object lets you load scenes in your scripts. You must
include “using UnityEngine.SceneManagement” at the very top of your code
to use these Scene functions.

em. Collections

UnityEngine;

You can load a new scene by name using the SceneManager.LoadScene
function. It takes one parameter: a string with the Scene’s name.

collision)

You can also use the Scene’s Index value in the Build Settings menu instead
of its name.

Click on File and select Build Settings.

File Edit Assets GameObject Comp
New Scene Cirl+N

Open Scene Ctrl+0
Save Ctrl+S
Save As... Ctrl+Shift+5
New Project...

Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B

Exit

& CODENINJAS'
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6 Once added to the build, you can see the index of each of your Scenes.

Build Settings n
Scenes In Build

v Scenes/Menu 0
v Scenesflevell 1
+ Scenes/level2 2

You can load a Scene by using its index as the parameter of the
SceneManager.LoadScene function.

r2D collision)

r.LoadScene (2) ;

& CODENINJAS'
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Examples
In Bronze Belt's Stacks, you loaded a Scene by name when the player
did not match the pieces.

21 Create a new IEnumerator X function and add the following:

IEnumerator X()

I
L

WaitForSeconds(3f);

r.LoadScene("SampleScene");

In Platinum Belt's Gravity Trails, you used the scene index to load the
second level after all the enemies had been removed and the Player
character collided with the portal.

1 1 1 Back in the conditional statement, use the SceneManager’s LoadScene
function to load the scene that is in build index 1.

Build Settings B

Scenes In Build
v Scenes/levell
« Scenes/level2

izion2D collision)

if(collision.gameObject.tag == "Player" && enemyCount == @)

eManager.LoadScene(l);

ldeas

Each new level in your game should be in its own Scene. If you want to
use game objects or other assets in more than one Scene, you should
make it a Prefab. When a Prefab asset is updated, the changes are made
everywhere and not just the active Scene.

& CODENINJAS'

Copyright © Code Ninjas, LLC |69




Camera

The Camera determines what the player sees when they play your
game.

# Scene
Shaded

= Hierarchy

+v

~ll[[ ¢ [ |~ 0|5 |- 1K (W« cizmos - | en_____]
y

a v < SampleScene

n Y — 711 Directional Light

When you select the Main Camera in the Hierarchy, you can see a
Camera Preview window in the Scene tab.

@ CODENINJAS'
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Instructions

1 The Camera component has two different Projection types that alter how
the Camera views your scene, Perspective and Orthographic.

2 When your camera has the Projection set to Perspective, your Scene will
have depth. This means that items far away from the camera will look
smaller than items closer to the camera. This will typically be used in 3D
games, although some 2D games can use it to create an illusion of depth.

v Bl v Camera @ = :
Clear Flags Skybox =
Background I
Culling Mask Everything -
Projection [Perspective -]
FOV Axis Vertical -
Field of View @ 60

Physical Camera

Note: Perspective property can make some 2D sprites look weird or
incomplete.

@ CODENINJAS'

Copyright © Code Ninjas, LLC |71



3 You can zoom your camera in or out by using the Field of View property.

Clear Flags
Background
Culling Mask

Projection
FOV Axis
Field of View

v W v Camera

e 3t i
Skybox
_f
Everything
Perspective
Vertical A
. 10.3

The Orthographic Projection removes depth from your scene. This setting is
most often used in 2D games.

Display 1 ~|Standalone (1024x768) ~ Scale ®— 0.43¢

¥ Wl v Camera
Clear Flags
Background
Culling Mask
Projection
Size
Clipping Planes

Viewport Rect

Skybax

_f

Everything

[Orthographic

S

Near (0.3

Far 1000
X0
W1

Y0
H 1

5 The Size property will zoom the camerain or out.

¥ Wt v Camera

Clear Flags
Background
Culling Mask

Projection

Size

e
Skybox
_ ’
Everything
Orthographic -
E ]
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Examples
In Bronze Belt's Meany Bird, you learned how to position objects in the
view of your camera. You also resized the game objects to ensure they
all fit properly.

8 Mew the bird is too big for the game view, so let’s change its size. In

the Inspector window, with the bird still selected, change the size of
the bird to these scale values:

o Brd | Static =

Tag | untagged 2| Layer @ Default *
¥ A Transform Lae
Position X 0 Y0 Z -1
Rotation X O Y0 Z|0

Sesle %[0.153 |Y[0.161 JZ[1T |
Scale values: X: 0,153, ¥: 0,161, 211

Yaur bird should look like this in both the scene and game windows:

T -

e

— [P —— e e

Ideas

If you don’t need your camera to constantly follow a game object you
can position the Main Camera where it can see the necessary game
objects and keep it there.

When you build a 3D game, it is best to set the Projection property to
Perspective so the player can be aware of how far or close they are to
the objects in the scene.

@ CODENINJAS'
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Cinemachine

By default, Unity games have a basic camera that can be difficult to
control. By using the Cinemachine package, you can manage your
game's camera without programming.

&j v CMvcami ~ Staticv
- Tag Untagged v Layer Default v
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Instructions

1 New Unity projects do not start with Cinemachine installed. Select the

Window menu and click on Package Manager.
W Help

Next Window Ctrl+Tab
Previous Window Ctrl+Shift+Tab

Layouts >
Asset Store Ctrl+9

Asset Management >
TextMeshPro >

General
Rendering
Animation
Audio
Sequencing
—deabyde >

L Y "

2 A pop-up will appear on your screen. Find and select Cinemachine from the
list on the left, then click on the Install button.

Last update Nov 25, 10:50 Install | Remove

@ CODENINJAS'
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3 After installation, a Cinemachine menu will be added to Unity’s menu bar.

File Edit Assets GameObject Componen Cinemachine Window Help

I W [ [S)center

4 Click the new Cinemachine menu and select Create Virtual Camera.

Cinemachine Window Help
Create Virtual Camera
Create FreeLook Camera
Create Blend List Camera
Create State-Driven Camera
Create ClearShot Camera
Create Dolly Camera with Track
Create Dolly Track with Cart
Create Target Group Camera
Create Mixing Camera
Create 2D Camera

Import Example Asset Package
AEout

This will create a new game object in your Hierarchy called CM vcam1.

= Hierarchy [
4+ (oAl
v € SampleScene*

) Main Camera
[7) Directional Light

@ CODENINJAS'
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Click on CM vcam1 and look in the Inspector. The Cinemachine Virtual
Camera component will let you control the behavior of your camera.

CM vcam1 [ ]

Untagged -

0.7489373i/ Y 0.728047:] £ -13.84766

10

MNone (Transform)
None (Transform)
Round Robin

Transposer A
Composer A
femlorth 4

The Follow property will attach the camera to a specific game object’s
transform. To change which game object the camera is attached to, click on
the small circle to open the Select Transform window.

‘ Select Transform

10

None (Transform)

@ CODENINJAS'
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Q

7 To make the camera look at the game object, you need to set the Look At
property. Click on the circle to the right and choose a game object from the
Select Transform window.

Select Transform =|

| v 4§ v CinemachineVirtualCamera @ 3
Q

Status: Live Solo
Assets  Scene |
= Game Window Guides v

@ CM veami Save During Play

[ Directional Light Priority 10

%Ga':”eobjem Follow None (Transform) =

Maln Camara Look At [None (Transform) G)]

Using both the Follow and Look At properties together will ensure that the
camera faces the game object it is following.

8 The Lens property determines the zoom factor of your camera.

When you use Orthographic View, the smaller the Orthographic Size, the
more zoomed in your camera is.

¥ Lens
Orthographic Size 8
Near Clip Plane 0.1
Far Clip Plane 5000
Dutch & 0

When you use Perspective view, the larger the Field of View, the more
zoomed out your camera is.

¥ Lens
Field Of View —®— 40 v
Near Clip Plane 0.1
Far Clip Plane 5000
Dutch @ 0

@ CODENINJAS'
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9 If your camera is following a game object,
you get an additional set of Body properties.

Adjusting the values of the Follow Offset property will change the position
of the camera.

Positive Negative

@ CODENINJAS'
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If your camera is looking at a game object, you can adjust it through the Aim
property. Notice the small, yellow square in your Game tab. This will help
you clearly see where your camera is looking.

By changing the values of the Tracked Object Offset you can tell the camera
exactly where it should be centered.

@ CODENINJAS'
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Examples

The Eyes on the Road section of Codey Raceway details different ways
to adjust the values so that your camera is behind Codey at all times.

46 Select CM veam1. Then, from the Inspector, drag the Codey from the
Hierarchy into the Follow and Look At properties in the Cinemachine Virtual
Carnera component,

(] CM veam e
Tag Urkuggad = Laper Dafau
® S Transterm o
v @ - CremichineVuskaman @ i
Stahuy e S0
Game Winsdow uide:
S uring Pay
Friceity "
Folow A Codey Trandtery 208

Lo &1 ACooey Tanstom B &
Stmndey Updme  Sound Rolan =
*Lens.

* Trsafions.

Sulky Slimes uses Cinemachine to make the camera follow the slime
and look at the targets.

27 Before we write the code that launches the slime, we need to make sure the
camera is behind the slime.

Open the CM veam1 object and adjust the Cinemachine Virtual Camera
component. The camera should follow the slime and look at the platform.
Set the values of the Body's Follow Offset to be behind and slightly above
the slime. Your numbers might be different than the image.

) 7/ cMveamt Static ~
" Tag Untagged ~| Layer Default =

A @ 3
v 4k - CinemachineVirtualCamera e !
Status: Live Solo
Game Window Guides
Save During Play [ |
Priority 10
Follow A Slime (Transform)
Look At A Platform (Transform)
Standby Update Round Robin

(o) (c]
<88

Transposer

Lock To Target With World Up
0 5 -12

Ideas

Use Cinemachine to focus the camera around your player. There are a
lot more properties to play around with and discover!

@ CODENINJAS'
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e
Rigidbody Physics

The Rigidbody component applies physics to our game objects. This
means that they will now act as if they are in the real world, affected by
gravity and other forces. Objects with Rigidbody components will fall
down automatically, have some weight to them, and can interact with

other objects in the scene.

o

Mone -
Discrete v
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Instructions

1 Add a Rigidbody component to your game object. Use the Rigidbody
component for 3D objects and the Rigidbody 2D component for 2D objects

and Sprites.

® Inspector ® Inspector

53 v GameObject ~ Static v @ /| GameObject ~ Static v
-
v Tag Untagged v Layer Default - Tag Untagged v | Layer Default -
v ). Transform e & i v /. Transform [ L
Position X 0.7493736 ¥ 0.7280473 Z -3.847656 Position X 0.7493736 Y 0.7280473  Z -3.847656
Rotation X0 Y 0 Z0 Rotation X0 YO &0
Scale X1 il 1 Z1 Scale X1 Y 1 a1
v & v Box Collider 9 i : v §# ~ Box Collider e 3
Edit Collider Va3 Edit Collider a3
Is Trigger v| Is Trigger v/
Material None (Physic Material) ® Material None (Physic Material) ®
Center X 0 Y0 Zo Center X0 Y0 Z0
Size X1 Y1 Z 1 Size X1 i 1 Z1

Add Component Add Component

Search Search
Rigidbody o Ricidbady
®»Rigidbody 2D Rigidbody 2D
New script > | New script >

The Rigidbody's Use Gravity property determines if your game object will be
affected by the Unity Physics Engine’s gravity.

v &  Rigidbody @ 3
Mass 1
Drag
ﬂnf:lllar nm? [a) f\s
Use Gravity

The Rigidbody's Is Kinematic property determines if you can apply forces to
the game object. If it is not checked, you will not be able to apply force using

code.
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4 Both 2D and 3D Rigidbody Components have a property called Constraints.
Adjusting these allow you to restrict the movement of your game objects
along an axis. If you do not want your game object to move or rotate in a
certain direction you can check the boxes next to the X, Y, or Z property to
restrict movement in the given direction.

Dynamic
None (Physics Material 2D)

Start Awake
None
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Examples

In Dropping Bombs, you used a Rigidbody and applied gravity to your
circles to have them fall down.

1 9 The Rigidbody component has many & g = !
. YA 20
parameters that can be adjusted to PR i
get the GameObject to respond to Drag 0
e - WESRINRIIE B
forc.es inside the game. Right now, [ useorsmty 5
we just want to have it respond re— o
to gravity, so make sure that Use Interpolate [ None :
. . Collision D 1 | Discrete :
Gravity is checked. Smmibed
» Info
. Default-Material Qe

In Robomania, you had to freeze the Z rotation to ensure that your
crushers did not rotate in circles when they moved.

2 6 d The Crusher1 game object now has a Rigidbody 2D component. The
only change we need to make is to freeze rotation on the z axis.

Open the Constraints dropdown and click the Z checkbox next to
Freeze Rotation.

¥+  Rigidbody 2D 3o,
Body Type T T—
Material [None (Physics Mater ©
Simulated 4
Use Auto Mass -

Mass (1

Linear Drag (]

Angular Drag 0.05

Gravity Scale i ]
Collision Detection |Discrete 4|

Sleeping Mode Start Awake N
Interpolate [MNene 4]
'/ Constraints
Freeze Position [ X []Y
Freeze Rotation W2
¥ Info

Ideas

Constraints give you control over how game objects react to your
world. You can freeze an object’'s Y position so it doesn’t move up or
down, or you can make it so the object doesn’t rotate when it's pushed.

You can uncheck Use Gravity on a collectable or other item that you
want floating in the air.
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Colliders

Unity uses colliders to determine when game objects make contact
with each other. Colliders give shape to game objects and enable them
to interact with one another.

There are many colliders in Unity that you can choose from. Four
common 3D colliders are Box, Sphere, Capsule, and Mesh Colliders. In
step 10 of Sulky Slimes, you can clearly see the difference between
each.

v % - Box Coliider e
Edit Callider e
Is Trigger
Material MNone (Physic Mater| &
Center
X0 ¥ 0.39 Z0
Size
X 08 Y o8 208

v & ~ Sphere Collider o
Edit Collider H
Is Trigger
Material None [Physic Materi ©
Center

X0 Y04 Z0
Radius 0.55

v ¥ - Capsule Collider o2
Edit Collider S
I Trigger
Material None (Physic Materi €
Center
X0 ¥ 0.38 Z0

Direction ¥ - Axis

v B ~ Mesh Collider @ 2
Convex <
Is Trigger
Cooking Options Mixed.
Material None (Physic Materi &
Mesh i Slime

All of the colliders perform the same job, but the collider you chose
depends on the shape of your game object. You have more freedom to
change the size of your Box, Sphere, and Capsule colliders. This is not
true with the Mesh Collider, as it tries to create a collider that fits your
game object perfectly. You also must be sure to turn on the Convex
option with the Mesh Collider to enable it to interact with other
colliders.
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When working in 2D, you have a different set of colliders to choose
from. We have focused on using the Box, Circle, and Polygon Collider

2D.

@ CODENINJAS'

v €} v Circle Collider 2D @ =

Edit Collider

Material
Is Trigger
Used By Effector
Offset
Radius
> Info

None (Physics Material 2D) O]

X0 ¥ 0

0.255

Edit Collider

Material
Is Trigger

Auto Tiling
Offset
Size

Edge Radius
¥ Info

Edit Collider

Material
Is Trigger

Auto Tiling
Offset

> Points

> Info

v [1 v Box Collider 2D @ it

None (Physics Material 2D) @

Used By Effector
Used By Composite

X 0 Y 0
X 0.51 ¥ 0.51

0

¥ £ v Polygon Collider 2D 0 3

'

None (Physics Material 2D) ®

Used By Effector
Used By Composite

X0 Y 0
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Instructions

To detect when game objects collide, they must have Collider components.
Go to the Inspector and click on Add Component.

O Inspector

@ v GameObject  Static~
- Tag Untagged v Layer Default =

v ).  Transform @ 3 i
Position X 07493 Y 0.7280. Z -3.847
Rotation X 0 Y 0 £ 0
Scale X1 ¥ 1 Z1

Add Component

Search for the collider that you want and click on it so that it gets added to
your game object. We are using a Box Collider as an example. Remember
that colliders can only collide with other colliders!

O Inspector

@ v| GameObject  Static~
- Tag Untagged » Layer Default =

¥ J).  Transform @ = i

Position X 0.7493 Y 0.7280.Z -3.847

Rotation X 0 YO0 Z0
Scale X1 Y1 Z1
¥ §# v Box Collider 9 i i
Edit Collider A
Is Trigger [ ]
Material None (Physic Mate ®
Center
X0 YO0 Z 0
Size
X1 Y1 Z1
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Each function has a parameter that represents the object that has been
collided with. You can check the different properties like the tag or name of
the object and run code if it matches certain conditions.

(Collision2D collision)

if (collision.gameObject.tag == "enemy")

(Collision2D collision)

if{cellision.gameObject.name ==

& CODENINJAS'
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4 Unity has special collision functions for both 3D and 2D colliders.

(Collision collision)

(Collision collision)

(Collision collision)

{(Collision2D collision)

(Collision2D collision)

{(Collision2D collision)

The only differences between the 3D and 2D colliders is that the 2D collider
functions have “2D" at the end of their names and the parameter types.

5 The syntax to check what objects we have collided with in our 3D functions
is exactly the same!

S CODENINJAS'
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(Collision collision)

if(collision.gameObject.tag == "enemy")

I
L

T
4]

(Collision collision)

if{collision.gameObject.name == "Boss")

I
L

1
I]

Let's look at how the different collider functions work.

OnCollisionEnter and OnCollisionEnter2D check for collision on the very first
frame when two game objects touch. If you use this function, know that will
only register a collision once, when the game objects first touch.

e Example: A projectile should hit an enemy only one time.

OnCollisionStay and OnCollisionStay2D check for collision as long as the
two objects are touching.
e Example: If your player’s character is standing on fire, they should take
damage the entire time they are standing on it.

OnCollisionExit and OnCollisionExit2D will run on the frame that the two
objects stop colliding.
e Example: If you have an object that acts as a switch for a countdown,
you want the clock to start counting down once the player is off the
switch.
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Examples

We have used colliders in every game that we have created. On step 14
in Sketch Head, you added a 2D Box Collider to help you determine
when the game object landed on a platform.

14 Afterward, click Add Component. Type Box Collider 2D in the search
box and select Box Collider 2D. Match the settings according to the
image below.

(R o " Wtexcolider20 el
- L& | Eat coder
S— Material Tione (Physics Ma] @
Is Trigger J
New »  UsedByEffector [
Used By Composite ()
Auta Tiing U
Offset
X0 ¥ ]
Size
X[E1 v €88 ]

Edge Radius R

* Info

For a 3D example, look at step 13e and 13f of Evil Fortress of Doctor
Worm. Remember how Codey could go straight through the grey box
rather than pushing it?

1 3e Click on Box Collider to add a Box Collider compenent to the GreyBox.

04 of Bon Collider Lze
Edt Colider
Is Trigger iJ
Materal tane (Physic Maten, ©
Center
%[0 ¥ [6% 2[e
Bige
xi0.7 Y1 Zjo.?

Ideas

You can use colliders to prevent a player from going into areas they
can't explore. You could also use them to determine if a player will take
damage if they interact with a object in the scene.
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Triggers

A Trigger is a special type of collider that lets you detect collision
without the objects stopping each other. Triggers are often used to
enable checkpoints and track other kinds of game events.
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When you want an object to act as a trigger, you must check the Is Trigger
box in the Inspector.

Edit Collider et
Is Trigger
Material None (Physic Mate &

Your game object will recognize when it touches another game object, but
will not prevent the object from passing through it.

Unity has special functions for both 3D and 2D triggers.

r other)

der other)

Exit (Collider other)

11ider?2D collision)

) collision)

) collision)

The only differences between the 3D and 2D triggers is that the 2D trigger
functions have “2D" at the end of their names and the parameter types.
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OnTriggerEnter and OnTriggerEnter2D run on the very first frame when two
game objects collide. Your object will still be able to go through it since it is
a trigger.

OnTriggerStay and OnTriggerStay2D continue to run as long as the two
objects are colliding with one another.

OnTriggerExit and OnTriggerExit2D run on the frame the object and the
trigger stop colliding.

To ensure that you don't run your OnTrigger functions for every single
game object, you can add a conditional that checks the colliding object’s
name or tag. This works for all six OnTrigger functions.

(Collider other)

if (other.gameObject.name == "door")

(Collider2D collision)
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<

Examples

In Ninja Run we used a trigger to create a pickup item! Step 8c shows
with a few of the many things we can do with triggers, such as adding
to a Ul, destroying objects, and playing animations.

BC Remember this emphasizes that a coin's been picked up, so it should
only play when the trigger event is called. We will use the functions
ParticleSystem.Start() and ParticleSystem.Stop() which tells
Unity when to play or stop a particle system.

Back in our Pickup script, under Start(), add:

Pickup.Stop();

InOnTriggerEnter(), add:

OnTriggerEnter(( r other)
I

ToString();

Pickup.Play();

In Chef Codey, Codey interacts with items in the environment through

triggers.
40 When Codey enters atrigger, we want to set the triggerName variable to
the name of the collider. When Codey leaves a trigger, we want to reset the
triggerName variable to an empty string.

Triggers can be used to automatically open or close doors based on a
player’s position. You can also alter different gameplay elements like
speed and gravity when the player is in a special trigger.

D, .
i’% CODE NINJAS
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Game Objects

Game Objects are a fundamental part of game development because
they make up every game you build. Game Objects can be anything
from simple 3D cubes or 2D squares to very detailed 3D models or 2D

sprites.
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Instructions

You can add a Game Object to your scene by right clicking in the Hierarchy
or clicking on the plus sign to open the menu.

+ - | a- All
Create Empty
Create Empty Child
3D Object
2D Object
Effects
Light
Audio
Video
ul

Camera —

WO W W

If you want to create a 3D object, hover over 3D Object and then select the

shape that you want.

+- [e Al

Create Empty |

Create Empty Child |

3D Object > Cube

2D Object > Sphere

Effects > Capsule

Light > Cylinder

Audio > Plane

Video > Quad

ul ? Text - TextMeshPro

Camera Ragdoll...
Terrain
Tree
Wind Zone
3D Text

3 If you want to create a 2D object, hover over 2D Object and select Sprite.

+ [ Al
Create Empty |
Create Empty Child | i
3D Object >
2D Object > Sprite
Effects > St
Light > Tilemap
Audio > Hexagonal Point Top Tilemap
Video > Hexagonal Flat Top Tilemap
ul > Isometric Tilemap
Camera Isometric Z As Y Tilemap
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To get a 2D game object to appear, you must fill the Sprite Renderer
component'’s Sprite property with an image.

v [g] v Sprite Renderer 9 3
Sprite [None (Sprite) ®
Color P
Flip X Y
Draw Mode Simple -
Mask Interaction None -
Sprite Sort Point Center v
Material Q New Material O]

¥ Additional Settings

Sorting Layer Default -
Order in Layer 0

You can use the Unity Asset Store to find amazing game objects to add to
your game.

You can search for a general type of game object like “2D sprite” or
something specific like “tree.”

& unity Asset Store

Q 2D sprites
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Examples
Every game that you created in Bronze, Silver, and Platinum Belts
contained different kinds of game objects! Load your previous projects

and export any game objects you want to use again as a .unitypackage
file.

ldeas

Game objects can be placed in your scene for decoration. Not all game
objects have to be interactive.

Prefabs

Prefabs (or Prefabricated Objects) are reusable game objects that can
be shared between scenes or games. Assets downloaded from the
Unity Asset Store are Prefabs that you can modify in your games.

Assets > Prefabs

>
Ny

GameObje...
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Instructions

1 Prefabs are created by dragging a Game Object from the Hierarchy to the
Project tab. You can create a new Prefabs folder to store all your saved
game objects. Once the Prefab is created, the name and icon will turn blue
to show that it is attached to a Prefab object.

B Project £ Console

4+~ =2
‘= Hierarch i
y v  Favorites Assets > Prefabs
+ - O, All Material:
v <} SampleScene* g ::: :;”U?EII)S ’
- refabs
7] Main Camera
[7) Directional Light v G Aseet- ~ ’
F?I MhA veramd B Artwork GameQbje...
¥ GameObject B Materials
a Prefabs
s Scenes
I Scripts

» Bm Packages

The Prefab game object can be dragged from the Assets folder to the
Hierarchy of any scene in your project.

2 By default, changes that you make to the prefab game object in the
Hierarchy of your Scene will only affect that instance of the object. To apply
your changes to all instances of the Prefab, open the Override menu in the
Inspector and click Apply All.

0 Inspector =
.‘i v GameObject Static~
- Tag Untagged v Layer Default -
Prefab Open Select | Overrides -
v T f Overrides tof’ GameObject
in Q Scene
Position X d
B xa T & GameObject
otation g # Concepts (Script)
Scale X1
v ﬁ - Box Collider ] Click on individual items to review, revert and
* apply.
Edit Collider Fat
e o Revert All Apply All
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3 Any changes that you make to your Prefab object will be automatically
applied to each instance of the game object in the Hierarchy of your Scenes.

Click on you prefab and make your changes in the Prefab’s Inspector.

Open Prefab

Q

GameObject ]

Untagged -

0.7493736 0.7280473 -3.847656

0 0 0
1 1 1

Notice that you no longer have the Overrides option as your changes are
applied right away.
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4 Sometimes you need to make special changes in only one Scene. You can
break a game object’s connection with the Prefab by “unpacking” the Prefab
in the Hierarchy.

Right-click on the blue object in the Hierarchy and select Unpack Prefab

Completely.
= Hierarchy |1

+ v [o Al

v < SampleScene*
[ Main Camera
[7) Directional Light
7] CM vcami

Copy
Paste

Rename
Duplicate
Delete

Select Children

Select Prefab Root

Open Prefab Asset

Select Prefab Asset
lInnack Prefah

Unpack Prefab Completely

In the Hierarchy, the text color of the game object will return to black and it
will no longer be connected to the Prefab asset. Be careful, because this
cannot be undone! Once you disconnect the object, you cannot reconnect it
later.

= Hierarchy

+ > (o Al |
v < Chef Codey* :
r:_ﬁ Maim S amara L
¥ [ PW_frenchtoast_egg
71 breadi
£ cream
0 egg
I7) Directional Light
F7 CM veami
» Z§ Codey Variant >
» 71 Room
» (7] Kitchen Objects
[0 Sources
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Examples
In Platinum Belt's Chef Codey, you may have learned how to unpack a
Prefab game object from the Asset Store.

27 Once you have your medel, you might have to separate the pieces to use in
your scene. If your object is not made out of different parts, then the next
steps might not be necessary.

=lln 8 [ [ o]0 5 - L e o -

LT L
M veam
» 0 Coday Varans 3
[ Roem
= [T Kilchen Gljects
Sources

28 Right click the blue object in the hierarchy and select “Unpack Prefab
Completely”. Remember to resize your object so it looks like it belongs in
your scene.

T
= Higrarehy

+ - | @ Al |

v ) Chef Codey* H
Copy 7 Main Camera -
Parta L Eﬂ FW_Trar Iﬂmm
Ren e E braadl
Duglicate FA eream

Dielete

Sakact Chidin 1 Miresrinnal | bt

Sebect Prefeb Faot @GM Wi ml

Tpen Mt » 5 Codey Variant ¥
Salact Prefah A » E71 Roam

Unpack Prefah » (71 Kitchen Objects

Unpack Prafab Comglrisly () Sources

Ideas
You should create Prefabs whenever you want to reuse a game object
across multiple Scenes.

The Assets you download from the Unity Asset Store will be Prefabs.
You can unpack the Prefabs to make any changes you want.
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Instantiate

Instantiating in Unity is a fancy way to say you are cloning an object.
The Instantiate function lets you specify which game object you want
to clone and the exact location you want to place it in your scene.

Instantiate() function.

Note: There is more than one way to use the Instantiate function. The
instructions below cover the most common syntax used for the
Instantiate function.

%CODENINJAS“
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Instructions

1 Create a GameObiject variable. You can set the value of this variable to a
prefab in the Inspector.

GameObject myGameObject;

2 You can call the Instantiate function anywhere in your script. Some
possibilities include when a button is pressed or when a collision is

detected.
if (Input.GetKeyDown ("sp
{
Instantiate (myGameObject)
Instantiate (myGameObject) ;
7/ .
@ CODENINJAS
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3 Once you decide when to clone the object, you must tell the Instantiate
function the game object it should clone, its position, and its rotation.

f (Input.GetKeyDown ("space"))

Instantiate (myGameObject, transform.position, transform.rotation):;

Different activities in Bronze, Silver, and Platinum belts modify the second
and third parameters of this function to control the exact position and
rotation of the cloned object.

& CODENINJAS'
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Examples

In step 11f and 11g of Shape Jam, you learned how to clone the
projectiles and how to position them either on the right or left side of
your player's game obiject.

1 1f We now need to add the right and left offsets to the position of our

new projectiles. In the first Instantiate, change the second argument
to be transform.position + rightOffset.

if (currentLevel >= 3)

rightoffset =

Instantiate(projectile, transform.position + rightOffset, transform.rotation);

In step 49 of Chef Codey, we introduced a new way of using the
Instantiate function. This form’'s parameters are: the game object we
want to clone, the game object we want as our new object's parent, and
either true or false to tell Unity how to position the new object in
relation to the world. Once the object is instantiated, you can set its
position by using its transform.

4§ Codey now has a piece of bread, but it's not in the best pesitien. Stop the

game and open your Interact script again. After the Instantiate line, we can
set the heldltem'’s position.

Ideas

You can Instantiate projectiles for your player or the enemies.

There could be times when you do not want the player to move objects
in the scene like in Chef Codey. You can clone the game object you

want the player to interact with rather than moving the original game
object.
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Translate

Translate is used to move our game objects in the direction that we
want. It takes three parameters that determine how far it moves on the

X, Y, and Z axes.

& CODENINJAS'
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Instructions

1 The Translate function is applied to a game object’s transform.

myGameObject.transform.Translate( ):

2 The Translate function takes three parameters. The first parameter
determines the distance and direction your game object moves along the X
axis.

myGameObject.transform.Translat e— 50, 401):;

3 The second parameter determines the distance and direction your game
object moves along the Y axis.

myGameObject. transform. Translate (15,] 504 40f);

4 The third parameter determines the distance and direction your game
object moves along the Z axis.

myGameObject.transform.Translate (15, -50, J401L)

& CODENINJAS'

Copyright © Code Ninjas, LLC |110




Examples
Find the Exit combines user input with the Translate function to move
Codey around!

In the Update function, we want to add one line of code to move our
ninja, Codey.

To do this, we will use Unity's Translate function on Codey's
transform. An object’s transform contains information about its
current position, rotation, and scale. Unity's Translate function will
let us change an object’s position. In the void Update() function, type
transform.Translate(Vector3.forward * speed *
Time.deltaTime); to tell Codey to move forward at our set speed of 5
at a constant rate of time.

transform.Translate(Vector3.forward * speed * Ti .deltaTime);

All we do when we Translate an object in Unity or in the real world is
move it from one location to another.

ldeas

You can use the Translate function to move game objects on a
consistent path. If you have obstacles that move from left to right, you
can use the Translate function inside of the Update function so that
they are always moving.
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Destroy

When you use Unity’s Destroy function, you completely remove a game
object from your game.
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Instructions

1 The Destroy function takes one parameter, the game object you want to
remove. Make sure to capitalize the letter D in the function name.

Destroy (myGameObject) ;

2 You can only call Destroy from of one of the Event Functions or a function
you created. Examples of Event Functions include Start, Update, and
OnCollisionEnter.

3 If you remove a game object that is needed in another script, Unity will
throw an error in the console telling you that other scripts are missing a
reference to the object you removed.

B Project B Console
Clear | Collapse Clear on Play | Clear on Build | Error Pause Editor ~ Q

[14:41:43] MissingReferenceException: The object of type 'GameObject' has been destroyed but you are still trying to access it.
Your script should either check if it is null or you should not destroy the object.
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Examples

In step 26 of the Meany Bird activity, you used the Destroy function to
remove the Spikes from the scene.

Create a new void function called DestroyMe, add this:

DestroyObject()

Destroy(gameObject);

In Chef Codey, you create the illusion that you pick up an item and place
it somewhere else by using the Destroy function.

8 Hmmm... this code should seem very, very familiar! We used these exact
two lines when we wanted to toast our bread slice. Since we are repeating
code, we can create a new function and use it any time we want to perform
these actions.

Outside of the Update function, create a private void function named
PlaceHeldltem. The bedy of this function should destroy the held item and
reset the held item's name to an empty string.

Ideas

It is important to give your player gameplay feedback so they can tell
the difference between an interactive game objects and background
images. Destroying a collectable is a great way to show your player that
they are interacting with the game world.

ia’%com: NINJAS'
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Raycast

A Raycast is the process of drawing a line, or ray, with a starting point,
length, and direction. They are often used to detect game objects
touching when a traditional collider won't work.

Note: If you can't see the
line, click on Gizmos.
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Instructions

The job of a Raycast is to check to see if it collides with another object.
Before you use the function, first create a Boolean to store the result.

rayDidHit:;

The Raycast function is often used in the Update function to continually
check for a hit.

rayDidHit;

()

The Raycast function needs three parameters: starting position, direction,
and length.

The first parameter, the starting position, takes a Vector3. You can start the
Raycast at the game object’s position with transform.position.

rayDidHit;
()

rayDidHit = Physics.Raycast (transform.position, ):
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The second parameter, the direction, also takes a Vector3. Since a Raycast is
a line, Unity needs to know which direction to point the Ray. You can create
your own Vector3 or use a built-in Vector3 like down, forward, or up.

rayDidHit;

0

rayDidHit = s.Raycast (transform.position, r3.forward, ):

The third parameter, the length of the Ray, takes a float value. This value will
depend on how far away you want to detect objects in your scene.

rayDidHit;
O

rayDidHit = Ph cs.Raycast (tkransform.position, Vec

Raycasts are invisible unless you use the Debug.DrawRay function. This
function takes four arguments: its starting position, its direction, its color,
and its length.

rayDidHit;

.Raycast (trans . ition, V 3.forward, 25f):
rm.position, forward, red, 25f);

@ CODENINJAS'
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7 While a simple Boolean will work in a lot of situations, there is an advanced
version of the Raycast function that lets you get information about the
object that the Raycast collides with.

First, declare a special RaycastHit variable.

8 Then, call the Physics.Raycast function with three parameters: its starting
point, its direction, and the keyword “out” followed by your RaycastHit
variable.

€ hitObject:

aycast (transform.position, Vect

The “"out” keyboard tells Unity to place information about the object the ray
hits inside the RaycastHit variable.
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You can use the different properties on the RaycastHit variable to run
different code based on conditionals.

it hitObject;
ast (transform.position, hitObject):
t.collider.CompareTag (" ok

if (hitOl distance < 10f)

& CODENINJAS'
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Examples

In Silver Belt's Jungle Escape, you used the Raycast function to
determine if Codey is on the ground. If the raycast does not detect a
game object beneath Codey, then the player cannot jump.

Now using what you've learned about Physics.Raycast() create a
function in Update that casts a ray from the player for a short distance.
Remember the three parameters: (origin, direction, distance).

Add the parameters as shown here:

Ideas

You could build a scene where there are multiple game objects in a
small location. You can use the raycast to help identify the specific
object that is in front of you.

Enemies can also use the Raycast function to determine if the player is
in front of them. If they raycast catches a player in front of them, then
they could chase the player.

%CODENMJAS
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Invoke
Invoke is a Unity function that allows you to run a function after a delay.
You should call Invoke when you want something to happen in the near

future.
This function has two parameters:
1) a string parameter that contains the name of the function we want
to call, and

2) an int value that specifies how long (in seconds) to wait until
calling the function provided in the first parameter.

In the example below, we have called the Invoke function so that our
game object is destroyed 3 seconds after the game has started.

GameQb

0 references

Destroy (myGameObject) ;
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Instructions

Invoke needs to know what function to call. You will need to create the
function first.

Destroy (myGameObject) ;

Once you have a function you want to use with Invoke, you need to decide
when to call it. You can use Invoke in Start, Update, OnCollisionEnter, or any
another function.

()

Invoke ("Destrc

0

Invoke ("Dest

(Collision collision)

Invoke ("Des

& CODENINJAS'
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The second parameter is the time in seconds to wait before calling the
function.

0

Invoke ("D

()

Invoke ("Destr

yllision collision)

Invoke ("L

& CODENINJAS'
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Examples

In World of Color, we used Invoke to delay our game from restarting so
that the player has a chance to get ready to play again. Notice that we
used Invoke within the GameOver function. You can call Invoke from
inside just about any function you want.

BETTER LUCK
NEXT TIME!

GameOver()

SCORE: 0

Reload()

SceneManager.LoadScene(@);

ldeas

Invoke is a great way to create game objects that get added to your
game. Just like with World of Color, CyberFu uses Invoke to give players
a break after a Game Over (see the PlayerHealth script).

Invoke can also be used to give the player time restrictions. In Chef
Codey, the Stove script uses Invoke to simulate the time required to
cook.
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- ‘
Player Input

Player Input is essential to enable users to actually play your game.
Unity can listen for input from a keyboard, a mouse, or a gamepad for
Player Input. You can customize the different types of Player Input in

the Input Manager.

Q
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Player Input will return a value if a certain key is pressed at any given
moment. We can constantly check if the player has given us the input we
are looking for inside of our Update function.

The Input object has several different functions to listen for Input from the
player.

GetKeyDown, GetKey, and GetKeyUp each take a key’'s name as a
parameter. This parameter can be a string or the KeyCode object.

After you type the period after KeyCode, you will see all the key value
options.

GetKeyDown will return true on the frame the user presses the key down.
GetKey will return true each frame the key is held down.

GetKeyUp will return true on the frame the user releases the key.

@ CODENINJAS'
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3 GetButtonDown, GetButton, and GetButtonUp take a button’s name as a
string parameter. You can view and edit the button names in the Project

Settings.

Edit Assets GameObject Component Cinem
Undo Selection Change Ctrl+Z
Redo Ctrl+Y
Select All Ctrl+A
Deselect All Shift+D
Select Children Shift+C
Select Prefab Root Ctrl+Shift+R
Invert Selection Ctrl+I
Selection b4
Preferences...

Shortcuts...

Then select the Input Manager to view the input options that you have.

nput Manager
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Copyright © Code Ninjas, LLC |127



To see the exact key values that each Input requires, click on the arrow next
to one of the options.

¥ Axes
Size 18
¥ Horizontal
Name Horizontal
Descriptive Name
Descriptive Negative Name

Negative Button left

Positive Button right

Alt Negative Button a

Alt Positive Button d

Gravity 3

Dead 0.001

Sensitivity 2

Snap v

Invert

Type Key or Mouse Button

Axis X axis

While buttons and keys have two values, just on and off, the Horizontal and
Vertical Axes can produce a range of values from -1.0 to 1.0. To account for
this, each Axis has a negative button and a positive button.

The Alt Buttons let you define a second key or button.

Since the Axes have a range of possible values, you must store the value of
the function with a float variable.

horizontalValue;

horizontalValue = I1 t.GetAxis ("Ho

@ CODENINJAS'
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6 If you use GetAxis with the keyboard, Unity will return a small value like
0.05f at first. If the key is held, the value will increase slowly to 1.0f (or -1.0f

for the negative button).

If you want to get only -1.0f, 0.0f, or 1.0f, then use GetAxisRaw. This
function will return only whole number values.

horizontalValue;

()

horizontalValue = Input.GetAxisRaw("Horizontal"):

& CODENINJAS'
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<

Examples
Silver Belt's Find the Exit uses the GetAxisRaw function to move Codey
around the maze.

1 1 Codey will still ignore user input because we haven't told Codey to
move based on the destination vector we just made. In the final line of
Update, change Vector3.forward to destination.

ination -

ve rtical™);
Vector?3 y tor3(h izontal, o,
U'an‘,ﬂ)rm.lr‘arnslar,‘ speed * o . deltaTime);

Platinum Belt's Sulky Slimes uses the three GetMouse functions.

1 6 Inside each of the if statements, put a print statement to check to see when
each of these will run.

Ideas

Every single game will require player input. You should playtest your
game with different control schemes to find the buttons and keys that
feel the best.

You should use the Input object any time that you want your game to
react to the player. This can be something like moving with the arrow
keys, opening a door with a mouse click, or jumping with the space bar.

D, .
i’% CODE NINJAS
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Movement Touch Controls

A virtual joystick can let your players move the characters using touch
controls. While you can create your own, using a free asset from the
Unity Asset Store can help you easily implement features.

@ CODENINJAS'
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Instructions

1 Open the Unity Asset Store by going to Window -> Asset Store. Search for
“joystick pack” and find the free asset named Joystick Pack by Fenerax
Studios.

| 1 » |G| R |§| ‘E‘ Open in Browser | English ~ = USD ~

) unity Asset Store

Q joystick pack

JOYSTICK BUNDLE j§
72

JOYSTICK
PACK
FENERAX STUDIOS LOVATTO STUDIO
Joystick Pack Joystick Bundle
ek (485)
FREE £10

- -

2 Click on Download to add the asset to your Unity account.

Home > Tools » Input Management > Joystick Pack

Joystick Pack

. Fenerax Studios
*dwhk 5| 438 Reviews

- ~ ;
O
- -
License Extension Asset
File size 487.0 KB
Jo I STICK PACK Latest version 21
4 Joysticks | 24 Des? ., 5 | Player Examples Latest release date Mar 25, 2019
Supported Unity 2018.3.0 or
versions higher
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3 Click Import to add it to your current Unity project.

Home > Tools > Input Management > Joystick Pack

Joystick Pack

. Fenerax Studios
ddddh 5| 438 Reviews

FREE

License Extension Asset

JOYSTICK PACK [

4 Joysticks | 24 Des7 5 | Player Examples Latest release date Mar 25, 2019

Supported Unity 2018.3.0 or
E - versions higher

4 On the Import Unity Package window, click Import.

Import Unity Package n

(o) e

&
&%)

ONOON 'w
4|4

4|

]
]
]
|

N
4]

EH
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The Joystick Pack files are now in your game’s Assets folder.

B Project | 2 Console
+ -
» o Favorites “~ Assets » Joystick Pack

M CasualGameSounds
» Im CoffeeShopStarterPack
Bm Game_music Decumentaion
» I lcons

v &= Assets
» Im 01_3D
B Animations i
» Im Asset Store
Examplas Spritas

Prafabe Seripte

aw Joystick Pack
Im Examples
I Prefabs

» Im Scripts

» I Sprites

I Materials

Since the onscreen joystick acts like a button, it needs to be placed inside of

a canvas game object.
i|omcame | . i
Maximize On Play | Mute Audio ‘S

= Herarchy | &1 ®lighng | #Scene | &
++ (oA | Shaded v||m||® w2 | wo|H -
v € kitchen scene*
Yy - .
» 7§ Codey Variant > ' CO”Ider
[7) Directional Light -—T X .
Timer

v | Scale @— 1x

Display 1~ |16:10

ff) Main Camera 4k
) Jams (8)
fl CM veami
» [0 FoodSources
Collider 7A7h?

7 Collider Label ‘|T"“P'r
71 Timer |
7] Inventory
F Message
7] EventSystem
ke FA Randam Dhisste

You can use an existing canvas or add one by clicking the Hierarchy’s Plus

button, then Ul, then Canvas.
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= ""ararchy # Scene

m ||_q- All

I Create Empty

Create Empty Child

30 Object >

20 Object b

Effects ¥

Light ¥

Audio b

Video >

M Text
o Cinemachine > Text - TextMeshPro

Camera Image
Raw Image
Button
Button - TextMeshPro
Teggle
Slider
Scrollbar
Dropdown
Dropdown - TextMeshPro
Input Field
Inout Field - TexthdeshPro

| m
] Panel
Scroll View
I Project Event System

7 Find the Fixed Joystick prefab and place it inside your canvas object in the
Hierarchy.

4+~ (a0 ]

-+

B Animations ‘ILSMS > Joystick Pack » Prefabs v <) kitchen scene* i

b B Asset Store B P rin miebinl ) Main Camera i
B CasualGameSounds [ ficosorsick | ¥ 0 Canvas

» Im CoffeeShopStarterPack - 7] Collider Label
B Game_music i Variable Joystick £ Timer

> B lcons

v @ Joystick Pack 3%, Ll

B Examples

R T T -

- ﬁ Directional Liaht

The Joystick Pack also has a dynamic, floating, and variable joysticks
available. Look at the documentation and examples to see how you can use
these prefabs in your game!
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8 Use the Fixed Joystick's Rect Transform component to adjust the anchor,

position, and scale of the virtual joystick.

o8 Game £ ] © Inspector |M 3
: *—— i = =
Display 1+ |16:10 ~ | Scale 1 Maximize On Play | Mute Audio ‘Slats Gizmos | * ﬁ ] Fined Joystick Static~
- Tag Untagged v Layer Ul v
Prefab Open | Select Overrides -
¥ ¢+ Rect Transform @
teft Pos X Pos Y PosZ
£ @ a0 40 0
g Width Height
256 256 & - |
¥ Anchors
Pivot X0 Yo
Rotation X0 Yo Z0
Scale X 06 Y 06 1
¥ (@  Canvas Renderer e
Cull Transparent Mesh
v [&l v Image e i
Source Image [El AllAxis_Outline o]
Color rd
Material MNone (Material) ®
Raycast Target v
Image Type Simple -
Use Sprite Mesh | |
Preserve Aspect

Set Native Size

Notice how changing the size of the game affects the joystick.

Play your game. Using your mouse, click and drag the joystick.

9

@ CODENINJAS'

Copyright © Code Ninjas,

LLC |136




To have the joystick control the character in your game, open your
movement script.

Add a new public Joystick variable and give it a name.

1 1 Inside the Update or FixedUpdate function, create an if else statement that
checks to see if the joystick is defined.

()

horizontal = Ii
vertical = Inp

if (joystick)

S CODENINJAS'
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Before the if statement, declare your horizontal and vertical variables, but
do not give them a value. We want to set the values based on the input

type.

horizontal;
vertic

(joystick)

If the joystick is defined, then set the horizontal variable to the value of
joystick.Horizontal and the vertical variable to the value of joystick.Vertical.

()

horizontal;
vertical:;

@ CODENINJAS'
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If the joystick is not connected, then set the horizontal and vertical variables
to the value of Input.GetAxis.

t horizontal;
vertical;

if (joystick)
]

1
horizontal = joystick.Horizontal:
joystick.Vertical:;

Save your script and play your game. Since we have not yet given the script
the joystick object, verify that your movement code still works with the
keyboard. Make sure you did not delete any variables or code that adjust
your character’s speed.

¥ # v Movement (Script) e
Script Mavement
Joystick Mone (Joystick) ® |
Movement
Speed 5
Movement Type All Directions v

Set the value of Joystick to your Fixed Joystick by dragging the object from
the Hierarchy or using the Select window.
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Uistance 1o srouna u
Select Joystick BI
(=] | ¥ # ~ Movement (Script) @ i+
a,
Asset5| Scene | [ e — .
Nonhe ‘ Joystick » Fixed Joystick (FixedJoystick) @
W Fixed Joystick Y,
Speed 5
Movement Type All Directions -

1 7 Play your game. Verify that the joystick moves your character and the
keyboard does not.

784235 =
‘ o

Based on your game’s character and scripts, you might need to add joystick
code in other locations. In Chef Codey for example, the character animations
are defined in the Player Controller script.

ywementV

if (movementVector.magnitude !
I
1

lastlook =

Repeat steps 10 through 17 to add your joystick to any other scripts that use
Input.GetAxis.
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¥ # ' Player Controller (Script) [ 7 s
Script PlayerControlle
Animator Clip = Codey Variant (Animator) 2]
On Ground
Distance To Ground 0
Joystick ¢ Fixed Joystick (FixedJaystick) @

(joystick)

horizontal = joystick.Horizontal;

vertical = joystick.Vertical:

horizontal
vertical =

3 movementVector = new V (horizontal, 0, wvertical).normalized;

if (movementVector.magnitude != 0)

I
L

lastlLook Quaternion.LookRotation (movementVector) ;

Playtest your game. Verify that the feature you updated works properly with
the joystick.
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Action Touch Controls

You can add touch controls to your game by creating a simple Ul with
buttons for each action.

SCORE: 5
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Instructions

This example will modify Silver Belt's Ninja Run game. We want to the user
to tap to jump and move lanes.

SCORE: 1

),

S CODENINJAS'

Copyright © Code Ninjas, LLC |144




2 Before you add a Ul and Buttons, make sure you have functions for the
actions you want to peform. For this game, we need Jump, Move Left, and
Move Right functions. Your function names and code should be specific to

your game.

JumpButton ()

if {!i1isGrounded)

rigidbody.velocity

dirtParticles.:
dustParticles.

MoveLeftButton () {

movel, = H

MoveRightButton () {

moveR
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3 Add a Button to your Scene.

‘= Hierarchy | 2 i | # Scene |
_ + > [a Al Shaded
Create Empty :
Create Empty Child
3D Object ¥
2D Object >
Effects »
Light ¥
Audic ¥
Video »
Ul » Text
Camera Text - TextMeshPro

Image

Raw Imane

Button
Button - TextMeshPro

Position the button and change its text and any other visuals

how the player will use the button on their touch screen.

. Think about

# Scene | i | mwgame | i | ® Inspector | Physics Debug =0
- ! - |45 | = - 16 -
Shaded |20 || ® [ | |~ 90| | ~|Displayl ~ 16:9 Scale @ — V] Juswp Bitton e
- Tag Untagged Layer Ul -
¥ % Rect Transform o 3t
el Fos AR RSy Hos 2
£ -50 50 0
3 Width  Height S
100 100 &l R
¥ Anchors L
Min %1 Y 0
Max X1 Y 0
Pivot X1 Blo
Rotation X0 ¥|0 Bl
Scale X1 il Z
@ CODENINJAS'
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5 Find your Button’s Button component in the Inspector.

Color Tint v
E Jump Button (Image @

0.1

Automatic A
Visualize

6 Add an action to the On Click () section by clicking the plus button.

Mone (Object) @
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7 Find your object that contains the function you want to use and drag it from
the Hierarchy to the None (object) slot of the On Click () section.

You need to use the object with the script and not the script itself because it

RuntimeOnv_ v | NoFuncton  ~

needs to have an object from the Scene and not an Asset.

8 With the correct object attached, click the No Function dropdown. Find the
script and the function you want to trigger when this button is pressed.

bool enabled

string name

bool runinEditMode
string tag

bool useGUILayout
BroadcastMessage (string)
Cancellnvoke (string)
Cancellnvoke ()

Mo Function

GameOhbject
Transform
Animator
Rigidbody

| e
SendMessagellpwards (string)
StopAllCoroutines ()
StopCoroutine (string)

Runti
ﬁc ae

*>
*
*>
*
*
*>
*

e Only =

GameCwver
Health
Pickups

Animation
Movement ¥
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Verify that you selected the correct function.

On Click ()

Runtirme Only *  Jump.JumpButton -
s Codey (Jump) @

Playtest your game and click your button. Make sure that the game is
behaving how you expect it to!

Repeat steps 2 through 10 to add buttons for your other actions.
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SCORE: 5

Ideas

You can use Ul Buttons to run any function in your game. If you plan on
touch being the primary way to play your game, then you need to
create buttons for every action required. You can use a script to
manage when to enable and disable different buttons.

& CODENINJAS'
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Particle effects are a way for you to easily add visual flair to your game.
They can be used to convey speed, danger, success, and many other
concepts to your player.
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Instructions

1 A Particle System is a special game object that exists in your scene. To
create a new Particle System, right-click an empty space in the Hierarchy,
select Effects, and then Particle System.

Create Empty

Create Empty Child

3D Object >
2D Object

Particle System Force Field
Trail

Line

The game object that is created has a special Particle System Component
with many different properties.

Open Editor...

.
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

Farticles/Standard Unlit -
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3 Each of these properties controls the behavior of your particle system. For

example, changing the shape will modify how your particles spread out from

the game object.

| OpenEditor.. |+

e
£

HHER

[«
{

dy
=
=|
H
9
15|
©

og &
=
o
=

o
< < <
o
MMM
Gl

X
A
1
o
(]
0

[ & | & | O @

{sphere =
[1.17

1

360

S

1
1101.69
{None (Texture 20)

4 Don’t be afraid to experiment with each property to see what it does. Your

options are almost limitless!

| OpenEditor.. | =
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You can use a custom mesh object or sprite image by changing the
Renderer property’'s Render Mode.

# Scene | ile Inspector

s e ————
taximum Lights
il
Custom Data
- Renderer
‘Render Mode Mesh -
Mesh | Capsule []
[+]
Material Q@ Default-ParticleSystem (@
Trail Material None (Material) ®
‘Sort Mode None b
Sorting Fudge 0 |
Render Alignment View -
F Im om-
Enable Mash GPU Instar -/
Pivat . A -
Particle Effect 8 | Visualize Pivat [
Restart Stop Masking NoMasking ________~
Apply Active Color Spa:
0.31 Custom Ver a
68.56 Cast Shadews off -
50 Receiva Shadows ]
50-50 Mation Vectors Per Object Motion >
Nuihlng = Sorting Layer ID Default A
(Nothing i | Order in Layer 0
Light Prabes off -
Reflection Probes off ~ /i
Curves } i
© Inspector
ansity Multipler
e
__ Custom Data
| Renderar
Render Mode Bilboard -
‘Normal Direction il
Material 9 CrX_YellowStar @
Trail Material None (Material) @
‘Sort Mode None hd
Sorting Fudge. 0
Min Particle Size o
Max Particle Size 0.5
Fender Alignment View
Flig A m-
Alow Roll /]
Phvat . A m- e
Restart Stop b s
Masking No Masking =
Apply Active Color Spac +
Custom Vertex Streams
Cast Shadows off -
Receive Shadows [
Shadow Bias o
Motion Vactors Par Object Motion -
Sorting Layer ID Defaun Y
Ordar in Layar 0
Liont Prahas -

Nt
Particle System Curves

6 By default, particle effects play when the game starts. You can change this
by disabling the “Play On Awake" property.

Sealing Mode Shape -
Play On Awake* |
Ermittomer L imleme ity il b m ol 4 -

If enabled, the system will start playing
automatically. Mote that this setting is shared
between all Particle Systems in the current particle -
effect.

Ring Buffer Mode Diza bled -
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There are two simple functions that let you control your particle system.
First, you must create a public variable and attach the game object to your
script in the Inspector.

Then, you can use the Play function to play your particle effect, and the Stop
function to stop your particle effect.

¥ # « Level Reset (Script) e 3
Script LevelReset
Explosion % explosion (Particle System) ®
Player o Player ®

GameOver ()

explosion.Play();

player.SetActive (

Invoke ("Re
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Examples
In Chef Codey, particle systems were used to communicate when food
was cooking and when it was ready to be picked up by the player.

1 21 Playtest your game and see what happens when you try to make toast or fry
an egg.

Ideas

Particle systems can be used in many different ways. You can use a
gold glowing particle system to indicate a special key, or add a particle
trail to an object that is moving across the scene to give it a sense of

speed.
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Materials and Textures

Materials can be added to game objects to change how they appearin
the scene. A Mesh defines a game object's shape, while a Material
defines a game object’s appearance. A Texture lets you wrap an image
over your game object’s surface.

New Material oo’
Shader Standard -
Rendering Mode Opague -
Main Maps
o Albedo -
© Metallic L
Smoothness & 0.5
Source Metallic Alpha 4

S Normal Map

D Height Map
2 0celusien
©Detail Mask
Emission
Tiling 1 i 1
Offset X0 ¥ O
Secondary Maps
@ Detail Albedo x2
O Narmal Map 1
Tiling X1 ¥
Offset X0 ¥ O
UV Set UvVo -
Mew Material LN RN
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Instructions

1 To keep things organized, create a folder called Materials to store any
Materials that you create or download.

B Artwork
I Materials
= Scenes
s Scripts

2 You can create a material by right clicking in your desired folder and
selecting Create, then Material.

A— T
Folder
C# Script
Shader >
Testing >
Create
Show in Expl Playables >
N oW in Explarer Assembly Definition
Dple'l Assembly Definition Reference
et TextMeshPro >
Rename
Copy Path Alt+Ctrl+C Scene
Prefab Variant
Open Scene Additive
Audio Mixer
View in Package Manager
0 —— Material
Imp”n P:V:B S5€L R Lens Flare
mport Package
. © Render Texture
Export Package..

Lightmap Parameters

Find References In Scene
Custom Render Texture

Select Dependencies

Sprite Atlas
Refresh Ctrl+R

N Sprites >

- Animator Controller
Reimpart All

s » Materials Animation
EiesFET Mk Animator Override Controller
Run API Updater. Avatar Mask
Update UlIElements Schema Timeline
Signal

Open C# Project

Remember to rename the new Material.

Assets > Materials

Purple
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3 To change the color, select the material and look in the Inspector. Click on
the rectangle next to Albedo, it will open a Colors tab.

Color n

© Inspector
Purple L2 R e
Shader Standard v RGB 0-255+
R T ][04
Rendering Mode Opague v BT
Eln Maps - e
~ oAlbedo - -
©Metallic [ 0 e EoCreT
Smoothness @ 0.5 ¥ Swatches
Source Metallic Alpha v O Click to add new preset

If you're wondering, Albedo is a fancy word that describes how much light a
surface reflects!

4 Drag the material onto a game object.

| Assets > Mat’ als

lels
abs

Purple.
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You can also find textures with different patterns and colors in the Unity
Asset Store.

Q) unity Asset Store €& unity Asset Store

Q Textures Q  Materials
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Examples

In Bronze Belt's Sketch Head Prove Yourself activity, you were
challenged to create a material to make the fake platforms stand out so
the player does not land on the platforms without colliders.

Ideas
Use Materials and Textures to turn your basic cubes and squares into
things like bricks and planks.

Not every game object has to look like the real world. Get creative when
applying textures - a tree doesn’t have to be made of brown wood!

@ CODENINJAS'
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Sound and Music

Adding sound and music to your game will make it feel polished and
complete. You can use music to set the mood of the scene, and sound
effects to immerse the player in your environment.

DM-CG5-15 DM-CGS-16 DM-CGS-17 DM-CGS-18
Dm-CGS-25 D-CG5-26 DM -CGE-27 Dm-Ci55-28
@ CODENINJAS'
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Instructions

Before you can hear your sound in your game, you need a game object that
has the Audio Listener component.

@ v Main Camera  Static~
- Tag MainCamera =  Layer Default -

1

» M Transform
b Wi | Camera
i i ~ Audio Listener
> 4k ~ CinemachineBrain

| 4

LR R -]
T

#

While this can be placed on any object, Unity’s Main Camera has one by
default. This component has no properties or settings.

2 To play music in your scene, you need a game object that has an Audio
Source component. You can use the Unity Asset Store to find music and

effects to use as your Audio Source’s AudioClip.
[@mspecor [ e e

| Music | Statie~
- Tag Untagged ~  Layer Default i
» M Transform e 3+
v 1l v Audio Source 0 i
AudioClip /1 DM-CGS-47 @
Output None (Audio Mixer Group) @
Mute ]
Bypass Effects

Bypass Listener Effects
Bypass Reverb Zones
Play On Awake

Loop

W NN |

Priority ® 128

g
'Y

Volume

Pitch

[ ]
o

Stereo Pan
Left Right

Spatial Blend L 0
- 2D 3D

Reverb Zone Mix L 1

» 3D Sound Settings

Add Compaonent
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Unity uses Spatial Audio to adjust the volume of the sounds based on how
far the Listener is from the Source. You can control how the interaction
behaves by modifying the 3D Sound Settings.

Logarithmic Rolloff
1
15

If you want to use a sound effect when a player performs an action, you
follow the same steps to create an Audio Source, but make sure to disable
the “Play On Awake" option.

S DM-CG5-47 @

None (Audio Mixer Group) @
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Your script needs to have a public AudioSource object that you connect to

your game object in the Inspector. In the script, you can use the Play
function to play your sound effect or music clip.

¥ #

Script

Task (Script) @ 3+

Task

Is Complete

Chime

Bell (Audic Source) @

: MonoBehaviour

Complete =

ce chime;
CompleteTask()

chime.Play();

isComplete =

DJ ()

-Play () ;
.Pause () ;
.UnPause () ;
.Stop ()
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Examples
In the Evil Fortress of Dr. Worm, sound effects and background noises
were used to make the player feel like they were trapped in an evil lair!

20C We need to add a Boolean to the LaserSwitch script that we can use to
inform the laser objects to turn off when Codey steps on the switch.

After private AudioSource playBeep; type public bool
lasersAreOff = false; to create a Boolean with a value of false.

switchIcon;
e playBeep;

lasersAreOff = ;

20d We want to turn the lasers off when Codey or the box enters the
switch. In the OnTriggerEnter function, add lasersAreOff = true;

after the playBeep.Play(); line.

playBeep.Play();
lasersAreOff = 5

Save your script.

Ideas

Adding sound effects to your game helps the player understand what's
going on in the scene. Some examples are a beeping that indicates a
time limit or a chime that plays when a door is unlocked. Background
music can be used to help transport your player into the setting. For
example, a spaceship might have electronic music, while a forest might
have soothing pianos.

& CODENINJAS'
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Tags
Tags let you label your game objects so you can find and compare by
tag instead of relying on a name, type, or component. They make

handling collision easy by letting you ignore all objects except the ones
you want to interact with.

0 Inspector

@ + Main Camera ~ Static~
- Tag MainCamera *  Layer Default -

v . T Untagged e + !
Position Respawn 5 |Z 1.94763
Rotation Finish V67 |Z 0
Seale EditerOnly 7 1

— % MainCamera

vy v C @ 3 :

Player

sl GameController -
Backgro r
Culling b Add Tag... -
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Instructions

1 Unity has several default Tags, but you can create your own by selecting
“Add Tag..." and adding one in the Tags and Layers menu.

O Inspector =
M Tags & Layers [+
¥ Tags
Listis Empty
.I.. -
Mew Tag Name Collectable] |
Save
3
Tag MainCamera =~ Layer Defa
T Untagged
sition Respawn
e Finish
e EditorOnly
MainCamera
v €
Player
YTEQS 50 GameController
ckgrot
Tag 0 Collectable _ Collectable
llirng h
+ - - Add Tag...
Hectio

Once created, the tag can be assigned via the Tag drop-down menu in the

Inspector.

2 If you need to find a game object based on its tag, you can use the
GameObject.FindGameObjectWithTag function to return the most recently
edited object with this tag. It is important to remember that if you have
more than one object to find, you can't reliably predict which one you will

get!

FindTaggedObject ()

ject .FindGameObjectWithTag("Collec

S CODENINJAS'
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If you want to find all objects with a specific tag, you can use the
GameObject.FindGameObjectsWithTag function. This will place all the
found objects in an array. You can then loop through the array and perform
actions on each of the objects.

FindTaggedObjects ()

ject.FindGameObjectsWithTag("Collectable") ;

To limit the objects that you can interact with, you can use a game object's
tag property or the CompareTag function inside a Trigger function.

(Collider other)
if (other.CompareTag("Player"™))

{

count. triggeredCheckpoints++;

(Collider other)

if (other
{

count.triggeredCheckpoints++;

@ CODENINJAS'
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Examples
Codey Raceway used tags to control the logic of giving Codey a power
up.

1 66 By default, chosenPowerup does not have a Game Object attached. After
we collide with the itemBox, we want to use randomNumberlnList to assign
a Game Object from the list to the chosenPowerup variable.

Robomania uses tags to make the enemy jump every time it collides
with the ground.

36d We need to tell Unity to apply this force to the Crusher's rigidbody
component by typing enemyRigidBody.AddForce(jumpForce);.

Ideas

Tags can be applied to any game object, so they are a great way to
control the logic of objects colliding with each other. Tags are also
useful when you need to find similar game objects, but you don't know
their names or cannot easily connect them to a public variable in the

Inspector.

D, .
i’% CODE NINJAS

Copyright © Code Ninjas, LLC |170




C# Concepts

[ STT s Lol o [ ) o 1T USROS RURRRURR
CONSONE ... et e et e e et e e et e e aae e
Conditionals and Booleans

SWItCR Stat@mMENTES. ... e e eae e
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Classes

A Class is used to organize objects and code together based on
functionality or purpose. You can design your game objects to have one
large class that controls all the logic, or you can create multiple small
classes that can be applied to different game objects.

: MonoBehaviour

countdown;

()

countdown —= Time.deltaTime;
if (countdown < 0)

I

L

Destroy (gameObject) ;
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Examples

In almost every game you are creating a script that does a specific job.
In Platinum Belt's Sulky Slimes, you created one class containing all the
logic required for the player to control the game.

-I 3 Create a new script in your Script folder in the Assets tab and name it Mouse
Manager.

Attach the secript to our MouseManager game object and open it in Visual
Studic.

¥ 2« Mouse Manager (Script) @ @

In Platinum Belt's Codey Raceway, you created a class that controlled
the movement of your shell game object.
1 72 The.l-ast thim_:-l to d;:.u is rnake. our éame 'T:Jl:;uj-ex'.:ts.-r:.:hs.lstrve;!nyr ‘;He o.t;.5tacles ln our"
track!

In the Seripts folder, create a new script and narme is ShellMovement, We
will use this seript to create the basic rmavement for the Shell. Attach this
script to the Shell game object in the prefabs folder.

C#

ShellMoveme. ..

ldeas

You should use scripts and classes to break up all the different actions
that your objects can take. Some classes might be specific to one game
object, while others can be attached to almost anything!
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Variable Types

All variables in C# need to have a Type. A variable's type determines
what kind of data it can store and how it can be used.

score = 42;

= 37.1f;

Tl'l_l-.

The door is locked"™:

Unity has a lot of unique variable types like GameObject, Sprite, and
Collider. The values of these variables can easily be set in your script’'s
Inspector.

A bool is a Boolean variable that can be either true or false. These are
used in conditionals to control the flow of your game.

An int is a whole number that contains no decimal values. It is useful
when you need to count things like the score of a game.

A float is a special type of number that can contain decimal values and
ends with the letter f. Floats are used when values need to be
calculated or measured.

A string is a how readable text is represented in code. Strings are used
when you need to log a message to the console or write out something
in your User Interface.

A private variable can only be accessed from inside its script. A public
variable can be viewed in Unity's Inspector and used by other scripts.

Variables are used in every game in the Unity belts!

S CODENINJAS'
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Floats

In C#, a number with a decimal value can be stored by using the Float
data type. A float value must always end with the letter f.

distanceFromDoor

In the example above, the distance a player is from the door is
represented by a float value because it could be a whole number or a
decimal number.

Examples

In Silver Belt's Robomania, you created a float variable that determined
how much force is applied to your Crushers.

32 We need to tell the crusher how high to jump. On the line after the
open curly brace { type public float yForce; to create avariable
that we can change in the Inspector tab.

ldeas

You should use Floats any time a value can be between whole numbers.
If you can’t use whole numbers to count your variable, then you should
use a Float.

%CODENINJAS“
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Functions

A function in C# works like any other function that you have created or
used before. Functions allow you to reuse code multiple times without
having to retype or copy and paste it over and over again. Functions
keep your code clean and easy to read. When you call a function, you
are running all of the code that is inside of it.

In the example below, when the function is called it will do two things:
remove the enemy and increment our score variable.

der2D collision)

{

LevelUp ()

}
1 reference
LevelUp()
{
myLevel++;
SceneManager.LoadScene (myLevel) ;
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Instructions

1 Every C# Function is made up of five parts: its visibility, return type, name,
parameters, and body.

First, you must decide if your Function is Public and can be called from any
script, or if it is Private and can only be called from its own script.

myPu blicFunction ()

If you do not declare your function to be Public or Private, Unity will treat it
like a Private function.

& CODENINJAS'
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2 Every Function runs code, but sometimes you need to calculate a result. C#
needs to know that kind of variable your function will return.

The most common return type is void. This means that your Function will
not return a value after it is called. Void Functions often modify existing
variables rather than create new ones.

If your function calculates a value or creates a variable that needs to be used
outside of the function, you must declare the type that it returns.

myScore;
ject collectable;

collectable.SetActive ( 0 e
myScore += GetRandomNumber () ;

GetRandomNumber ()

randomNumber = Random.Range (0, 10):
return randomNumber;

S CODENINJAS'
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3 Every Function needs a unique name. You should choose a name that
concisely describes what your Function does. If your function Instantiates
an enemy, then CreateEnemy is a much better name than something like
Spawn.

4 Functions can take any number of parameters. If you do not need to provide
any variables or data to your Function, you can leave the inside of the
parentheses empty.

5 If your Function does need outside variables or data, you must declare the
type and provide a name inside the parentheses.

UseInventoryItem (G:

Destroy(item) ;

In the example above, the function needs to know what item from the
player’'s inventory to destroy.

& CODENINJAS'
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6 If your Function requires more than one parameter, you must separate them
with commas.

ct powerup, count)

for ( i 0; i < count; i++)
I
1

Instantiate (powerup) -

In the example above, the Function needs to know what GameObject to
Instantiate and how many times to run the loop.
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Examples

In Bronze Belt's Dropping Bombs Part 3, you used a Function to control
how fast items spawned.

1 3 All that's missing is the ResetDelay function.

It's just a single line setting delay to equal a Random.Range between the
values of delayRange.x and delayRange.y

I
1

32 = void ResetDelay()
{
34 delay = Random.Range(delayRange.x, delayRange.y);
szl 3
36 }

In Platinum Belt's Codey Raceway, you created a Function that used
Invoke to reactivate the item boxes.

1 52 In this function we want to do the opposite of what we did in our
OnCollisionEnter function by using the SetActive function to enable our
gameObject.

@ CODENINJAS'
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Functions are used to easily repeat code without having to rewrite it
each time you need it. Any time you find your self thinking “this seems
familiar,” you should try creating a Function.

You can pair your Functions with the Invoke Function to make
something happen at a specified time in the future.

The Console is a useful tool that can help you program and debug your
game.

[13:50:16] I'm at the Stove
UnityEngine.MonoBehaviour:print(Object) [

[13:50:15] I'm at the Coffee Bar
- * / UnityEngine.MonoBehaviour:print(Object)

Enter (Collider other)

[13:50:15] I'm at the Orange triggerName = other.name;
UnityEngine.MonoBehaviour:print(Object) stationLabel.text — triggerName;
7y [12:50:11] 'm at the Trash ) . I . > e )
*  UnityEngine.MonoBehaviour:print(Object) o] rint ( I'm at the + tr igger Name ) ;

[13:50:09] I'm at the Egg
UnityEngine.MonoBehaviour:print(Object)

The print function will calculate the result of the parameter and write it
out in the console. In the example above, we are printing the location of
Codey each time a new trigger is entered.

While the print function will work for most situations, Unity's version of
C# lets you use Warnings and Errors to make them stand out.

[14:04:29] This is a print
UnityEngine.MonoBehaviour:print(Object)
1 [14:04:29] This is a Debug.Log
~* UnityEngine.Debug:Log(Object)

[14:04:29] This is a Debug.LogWarning
UnityEngine.Debug:LogWarning({Object)

[14:04:29] This is a Debug.LogErrar
UnityEngine.Debug:LogError{Object)

As you develop your game, you should rely on printing and logging to
help you understand what your script is doing when it runs.

If you ever find that your code isn't working like you expect it to, it can
be helpful to print the variable(s) that are acting up to diagnose the
problem.
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Conditionals and Booleans

A Conditional statement lets you control when certain blocks of code
run. If your condition is true, then the code inside the body of the
statement will run. If the condition is false, then the code will not run.
Conditionals are made up of if, else if, and else condition.

teleportToLevel ( levelName)

if (levelName == "Level 1")

r.LoadScene (1) 7
1Name == "Level 2")

eManager.LoadScene (2) 7

SceneManager.LoadScene (0) ;

You can use the conditional operators to create your conditional

statements.
Statement Definition
A== Returns true if A is equal to B.
Al=B Returns true if A is not equal to B.
A>B Returns true if A is greater than B.
A>=B Returns true if A is greater than or equal to B.
A<B Returns true if A is less than B.
A<=B Returns true if A is less than or equal to B.
A &&B Returns true if both A and B are true.
Al|B Returns true if A is true or B is true.
A Returns the opposite of A.

Note: The “|" symbol is found by holding shift and pressing the “\" key.

You can use a combination of all the conditional operators to create
complex conditional statements.
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Examples
In Platinum Belt's Sulky Slimes, you used multiple if statements to find
out when certain mouse events were performed.

1 Inside each of the if statements, put a print statement to check to see when
each of these will run.

Ideas

You can use conditional statements to unlock a door only if the player
has collected a key. You can use a combination of all the conditional
operators to create complex conditional statements like in Chef Codey.
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Switch Statements

A Switch statement is another way of writing conditional that checks
the value of one parameter. It runs different code cases based on the
parameter’s value.

)
L

>r . LoadScene (1) ;

~r.LoadScene (2) ;

=r.LoadScene (3) ;

. LoadScene (0) ;
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A Switch statement takes one parameter that has distinct possible values.

Strings and ints are often used as parameters because they have clear, exact
values.

teleportToLevel (

7itch (levelName)

The body of a Switch statement should contain at least one case. Cases are

created by using the case keyword, the value you want to look for, and a
colon.

teleportToLevel ( levelName)

switch (levelName)
I
L

If the paramter’s value matches the value checked in the case, the code
after the case will run until it reaches the break keyword.

teleportTolevel (

switch (levelName)

r.LoadScene (1) :

@ CODENINJAS'
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You can add as many different cases as you want.

teleportToLevel (

switch (levelName)

All Switch statements should contain a default case that runs if no other
case conditions are met.

er.LoadScene (1)

~.LoadScene (2) ;

er.LoadScene (3) ;

~ . L.oadSce
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Examples
In Silver Belt's Food Frenzy, Switch statements are used to perform a

task depending on the level that the player is on.

1 oe What's left to do is madifying the subtext objects depending on which
of the three levels is being played. Inside a SetLevel Type function,
we'll ba taking the Level. LevelType type parameter, and applying a
switch/case statement to adjust text objects accordingly.

public void SetlevelType(Level.LevelType type)

{
switch (type)
case Level.levelType.MOVES:
remainingSubtext.text = "moves remaining";
targetSubtext.text = "target score”;
break;
case Level.levelType.O0B5TACLE
remainingSubtext.text = "moves remaining";
targetSubtext.text = "dishes remaining";
break;
case Level.LevelType.TIMER:
remainingSubtext.text = "time remaining”;
targetSubtext.text = "target score";
break ;
1
i

Ideas

While you can always use a series of if and else conditional statements,
a Switch statement is useful when you are looking for specific values of
one variable. You could use a Switch statement to run code based on

the button a user pressed.
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Arrays

An Array stores a set of similar data in a specific order. The individual
elements inside the Array can be used through their indexes.

Arrays and Lists are very similar, but the size of an Array cannot change.
This means Arrays are good to use when you know exactly what
elements it needs to contain.

[1 fractions
randomIndex = Ra

return fractions|[randomIndex];
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Instructions

Instead of declaring an Array with the keyword Array, you use the type of
data you want to store followed by square brackets.

[] myStrings;

2 Once you declare an Array and give it a name, you can fill it by placing your
data inside curly brackets and separated by commas. Note that in an array,
the first item is located at index O, the second at index 1, and so on. So, in
the example bellow, “Hello” is stored at myStrings[0] and “world!" is at
myStrings[1].

[] myStrings "Hello", "world!" };

If you try to Add or Remove an item in an Array, you will get an error
because the size of the array cannot change.

myStrings.Add ("Gc

‘string[]’ does not contain a definition for "Add’ and no accessible extension method *Add’ accepting a first argument of type 'string[]*
could be found (are you missing a using directive or an assembly reference?)
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While an Array does not let you add or remove items, you can modify
elements at specific indexes.

myStrings[1l] = "Goodbye!";

print (myStrings) ;

Loops can be used to iterate through each element in an Array in order.

Typically, the loop index will start at 0 and go up to the number of elements
in the Array. It should increment by one after each time through the loop.

In the body, you can access each element by using the loop's index variable.

< myStrings.Length; i++)

print (myStrings[i]);

@
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Examples
In Sulky Slimes, we used an Array to hold three Ul images. Look at steps
57 through 63 to see how to remove specific images from the Ul based

on their index.

62 Since our three heart images are active when the game starts, we just need
to disable a heart each time a player loses a life.

When the player loses a life, disable the heart object in the hearts array
based on the current value of lives.

ldeas
You can use an Array to hold references to images used in Ul elements
or a set of powerups. It is important to remember that once you define

the contents of an array, it cannot grow or shrink!
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Lists

A List in C# stores pieces of similar data in a specific order. The
individual elements inside the List can be accessed using their indexes.

While Arrays and Lists seem very similar, C# treats them as two
different types. Most importantly, the size of an Array cannot change
dynamcially, but a List can shrink or grow based on your code. Because
we are using Unity, you won't notice many behind the scenes
differences between the two types.

In the example below, a function uses a list of three strings to return a
random food item.

GetRandomFood ()

b
randomIndex = Random.Range (0, items.Count) ;
return items|[randomI
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Instructions

1 A List is different from most other types because it is just a way to hold
other pieces of data. When you want to create a new List, you must use
special syntax that declares the type of data it contains.

1g> myStrings;

> mylnts;
I r

2 Once you declare a List with a type and give it a name, you need to initialize
it. This is another big way that Lists are unique.

First, you must declare a new List of the correct type. Then, you use
parentheses to create the List and curly brackets to define the contents of
the List. The items in the list need to be the correct type, and they must be
separated by commas. The final syntax looks very similar to a Function!

& CODENINJAS'

Copyright © Code Ninjas, LLC |194




3 Now that you have your List, you can access what's inside through their
indexes.

Like most other things in Computer Science, the first element in a list is at
index 0O, the second element is at index 1, and so on.

print (myStrings[1]);

print (myStrings|[0]);

4 Lists provide you with some special functions that let you read and modify
them.

Use Count to return the number of elements contained in the List.

print (myStrings.Count) ;

5 In C#, you cannot just use + and - to modify a List.

Use Add to place a new element at the end of the list.

myStrings.Add ("Good

print (myStrings) ;

6 Use RemoveAt to delete an element at a specific index.
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myStrings.RemoveAt (1) ;

print (myStrings) ;

7 Loops can be used to iterate through each element in a List in order.

The loop index should start at 0 and go up to the number of elements in the
List. It should increment by one after each time through the loop.

In the body, you can access each element by using the loop's index variable.

< myStrings.Count; i++)

print (myStrings[i]);

S CODENINJAS'
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@ CODENINJAS'

Examples

In Codey Raceway, we used a List to hold the powerups a player could
use. Note how the Powerup List variable was defined though the Unity
Inspector instead of code. Look at steps 159 through 167 to see how
powerups were randomly selected from a List.

1 60 Save your script and return to Unity. Click on Codey and in the Inspector, we
need to update the Select Random Powerup Script component.

Change the size of the Powerup List from 0 to 2.

¥ o4 o Select Random Powerup (Scrij Ty
¥ 4 ¥ Select Random Powerup (Script) @ Script + SelectRandomPowerup o
Script = SelectRandomPowerup (<] ¥ Powerup List
¥ Powerup List Size 2 1
Size I — R sl None (Game Object) °
. . Element 1 None (Game Object) -}

Collect an item box and see how the public variables in the script change.

Ideas

A game’s inventory system could be represented by a List. The player
can add items, remove items, and look through each item. The
individual items could have unique properties just like the shells in
Codey Raceway. Since the size of the inventory would change throught
the game, a List would be a better choice than an Array.
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For Loops

A For Loop is made of three parts: a starting index, a run condition, and
instructions on how to change the index after each time through the
loop.

CountToTen ()

for ( index = 0; index <= 10; index++)
I
L

print (index) ;

& CODENINJAS'
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Instructions

1 Each For Loop starts with the keyword “for” followed by parentheses.

2 Inside the parentheses, you must declare an integer variable to be the index
of your Loop. You can name it anything you want, but common names are
index and i.

You can name it based on what you are looping through. For example, if you
are looping through all the enemies in your Scene, then you could name the
index variable enemy.

You must also declare an initial value for your variable. This will typically be
0.

3 The second parameter is the run condition. Your Loop will run only while
this condition evaluates to true. Once it evaluates to false, your Loop will
stop running.

Use your index variable in your conditional statement.

; enemy < arrayOfEnemies.Length;)
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The last piece of code that goes inside the parentheses is how you want to
change your index variable after each Loop. Most often you will add or
subtract one.

enemy = 0; enemy < arrayOfEnemies.Length; enemyi+)

5 Use curly brackets to make the body of your loop. The code inside will run
each time the value of your index variable makes the conditional statement
true.

enemy = 0; ene < array0 emies.Le ; enemy+t
enemy 0 nemy rrayOfEnemies.Length nemy++

Destroy (arrayOfEnemies [enemy] ) !
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Examples

In Bronze Belt's Sketch Head, you used a For Loop to spawn up to 999
platforms!

Next, type inside the void Start function:

0; i 1000; i++)

SpawnPlatforms();

//Integer i equals 1000
for (inti=0;i < 1000; i++)

//Execute SpawnPlatforms
SpawnPlatforms();

}

In Platinum Belt's Codey Raceway, we used a For Loop to spawn our
item boxes. You could change the number of item boxes by changing
the index variable.

1 31 After checking in with your Code Sensei, we want to Instantiate a new
itemBox each time the loop runs. Name it itemBoxClone.

ldeas

If you do not want to individually place all the game objects in the scene
as you build your game, you can use a for loop to help you position your
game objects. This could be different platforms, enemies, obstacles or
powerups.

If you store any data or game objects in an array, then you can perform
code on each one by writing a For Loop.
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